THE BARCODE EXPERTS
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2D & linear barcode verifier
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This user guide was made using:
2.1.0 version of the Axicon Camera Verifier Software for Windows.
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Introduction

The Axicon 15000 series verifiers are designed to work with any PC running a
currently supported version of Windows (Windows 7, Windows 8, Windows 10 - both
32 bit and 64 bit versions).

Specification and application

The 15200’s field of view is 60mm x 45mm, and is designed to verify linear and 2D
barcodes, including those used on retail point of sale and healthcare items. These
are typically EAN/UPC or GS1 DataMatrix symbols.

The 15500’s field of view is 95mm x 70mm, and may be used to scan a larger range
of barcodes at different sizes. These include all GS1 symbols, and Code 93, Code
128, ITF, MSI Plessey - if they are no wider than 95mm.

The software is able to decode the following symbols:

Linear barcodes: EAN-8, EAN-13, UPC-A, UPC-E, Code 39, Code 93, Code 128,
GS1-128, Codabar, ITF, MSI Plessey, GS1 DataBar, Laetus Pharmacode.

2D barcodes: Data Matrix, GS1 DataMatrix, QR Code, GS1 QR Code and
GS1 Composite Code.

Application standards: Data content checking can be carried out on all the symbols
that have been verified. This includes check digits, and combinations of

GS1 application identifiers and their element strings especially for various
healthcare applications.

Multiple barcodes within the field of view will be found and can be verified to the
appropriate standards.
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What is in the case.

o Axicon 15000 Series verifier

» Software CD

» Wallet containing this user guide, calibration card and certificate of
conformance 1SO 15426

e Cleaning cloth

System requirements

e Currently supported Windows Operating System (either 32 or 64 bit)
o 100 MB disc space

e 512 MB RAM minimum

o USB 2.0 port or higher

Software installation

Insert the CD into an appropriate drive and the Install program should start
automatically. If it does not, run autorun.exe. When the software has been
successfully installed, leave the CD in the drive, so that the USB driver will be
installed when the verifier is connected to the computer. The software is called
Axicon Camera Verifier, and the latest version can always be downloaded from the
Axicon website, www.axicon.com. The software will check automatically if a later
version is available. It can be used on any PC or laptop to view the verification scan
files that have been saved even when the verifier is not connected.

Hardware installation
Connect the USB lead from the verifier to a USB2 or USB3 port on the computer.
Please install the software before connecting the 15000 series verifier.

Axicon Auto ID Limited | 15000 series verifier user guide | June 2021
Page 5 of 32



www.axicon.com

How the verifier works

The verifier must be connected to a PC or laptop that is running a currently
supported version of Windows using the USB connection, and used with the Axicon
Camera Verifier program.

The verifier has two buttons, which both do the same thing, and either one is
pressed to turn the verifier on. The image capture process will start and you can
see what the verifier sees on the main software window. When the barcodes you
want to verify are in the right place, press one of the buttons again to begin the
decoding and verification of the barcodes.

Ideally each barcode should be verified when it appears on the final filled item,
in its final configuration. If the packaging by itself is verified, and is completely
covered by the verifier, the verification process will be good.

If the verifier is placed on its side, or upside down, take care to minimise the effect
of ambient light. Ensure that any semi-translucent substrates are backed by a
uniform black surface to minimise the effect of light being transmitted through the
substrate.

There are two buttons so that you can easily use the one that is most convenient if
you have the verifier on its side or upside down. The keyboard shortcut Ctrl + G is
the equivalent to pressing the button.

The image that has been captured and decoded can be saved as a scan file (.png),
and this can be re-verified at any later time. The software allows the creation of
verification reports for each barcode that appears in the image, and the user simply
clicks on the relevant barcode for which a report is required.

More details about this process, saving scan files, and saving verification reports are
explained later on in this user guide.
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Calibration

When you use the verifier for the first time, it will tell you that it must be
calibrated. This will ensure that its reflectance measurements are correct.

Take the calibration card from the plastic wallet, and place on a flat surface. Place
the verifier over the EAN-13 barcode or the Data Matrix code so that it appears in
the verifier window.

Then choose calibrate from the reader menu. The verifier will ask you to confirm
positioning and that the Rmax and Rmin figures shown on the window match those
printed on the card. If they are different, alter the numbers via the calibration tab
in the settings menu and restart the calibration process. You will then need to press
start.

The verifier software will then check the image, calibrate, and recheck the image.
When this has been done a message ‘Calibration Successful’ will be shown. After
this message, another scan will be made so that you can check that the verification
results are correct. The Rmin and Rmax figures need to agree with those on the
calibration card.

The calibration card supplied with the verifier provides barcodes with known
maximum and minimum reflectance values. The calibration card is certified for a
minimum of one year (unless it has been physically damaged).

When it is not being used please keep the card flat in its plastic envelope, and away
from direct sunlight. If the card shows any sign of damage - for example, scratches
or any change in colour - please obtain a new card from us.
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Getting started

After calibration, the home window for the software will look this:

& Avicon Camera Verifier

The window main areas are explained below.
FEile View Reader Help

PoH = PRSOR

oooooo Brint Report: “Standard PDF* | S
General Reader Scan

EAN-13

5012345678900
EAN-13

Pass grade
* X Dimension

+ Print Gain
Check Character
Height 229 mm
Wi

o Left Quiet Zone 10 items: 10 Pass,
* Right Quiet Zone 10 items: 10 Pass.

57012345%T

“““ g

v GS1 Retail

5012345678900

The top section includes the file menu and the toolbar with its command icons.

The File menu includes options for saving and loading scans, creating and printing
reports. The View menu gives access to Settings (F5) and User data.

The Reader menu provides options for choosing which verifier is operational, reader
information,scanning, decoding, and calibrating the reader (the verifier).

The Help menu provides access to the Axicon website, a check for software
updates, and information about the software.

Axicon Auto ID Limited | 15000 series verifier user guide | June 2021
Page 8 of 32



www.axicon.com

The Command icons on the tool bar are as follows:

‘\I% Quit the application, or use Ctrl + Q

Load a saved barcode image, or use Ctrl + O

Save the current image and verification report, or use Ctrl + S

Print, or use Ctrl +P

Start collecting barcode images in the field of view, or press one of the two

buttons on the verifier. This will be orange when the verifier is connected and
grey when it is not. It will change into a pause icon when scanning.

VI1E

Stop collecting images from the current reader.

Decode barcodes in the current image. This will change into a stop icon when
the barcodes are being decoded.

Stop searching for barcodes.

Edit the settings for the application, or use F5

Used to calibrate the hardware, or use F2.

OOl 3

Display and edit user-defined data for this scan.
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Getting started

The top right section provides the overall results for the verification. It will provide
the grade in the format n.n/aa/www (X), where n.n is the ISO/IEC grade, aa is the
aperture reference number, www the wavelength of the light being used for the
verification in nanometres and X is the ANSI equivalent.

This panel also has three tabs, where the first set of information about the barcode
is shown.

The General tab will show you the decoded data from the symbol, its x and y
dimensions, the print gain, and the aperture size.

The Reader tab simply gives you detailed information about the verifier such as its
serial number and build version, and when it was last calibrated.

The Scan tab provides details of when the image to be verified was scanned by the
verifier.

The bottom right section includes two tabs; ISO and Details.

The ISO tab will include details of all the parameters defined by ISO/IEC for the
particular barcode being verified.

The Details tab provides a breakdown of the results by individual scan line and by
parameter for linear symbols only.

The bottom left panel will include details that relate to the analysis of a symbol by
one or more of the optional plugins. Plugins are chosen by the user and they will be
used to check if the symbol meets the requirements of one or more applications.
More information about this is provided later on in this user guide.

The status bar is at the very bottom of the window, and provides details of what
the verifier is doing. If a verifier is not connected, the message ‘Found Readers 0’
will appear in the status bar. When a verifier is connected, the message will be
‘Selected reader: xxxxx’, where ‘xxxxx’ is the serial number of the verifier.
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Operating the verifier

Make sure the Axicon Camera Verifier program is open, the verifier is connected,
and press one of the buttons on the verifier or press the orange ‘Start scanning’
arrow on the toolbar. Then place the verifier over the barcode(s).

The message ‘Scanning’ will appear in the status bar at the bottom of the window.
With the verifier held still, press one of the verifier buttons again to begin the
decode process. You can also press the ‘decode’ icon in the tool bar. Do not move
the verifier until ‘Cancel decode’ appears or all codes have been found.

> @@r

an( el Decode | Seftings.. Calibrate.. | Use:

Print Rey
RF.F 80000527 REF 80000527
i 201701 @ 2017-01 ene! Bmioe

T| 12051234 LOT| 12051234
Gnu 7332551925352

GTIN 7332551925352

REF 80000527 |
(tor] 12051234 |
| 7332551 '9a535¢ @ 201701

REF 80000527 | s
[Lor] 12051234 |

52254 1058282 P

The verlﬁer will draw a purple box around each of the barcodes it has found. You
must click on one of these to select it, and then the results will be displayed. Click
on any other barcode to see its results. Clicking on the selected code will zoom in.

When only one symbol is present the code will be selected automatically. To verify
the next barcode, simply press one of the verifier buttons or the orange arrow

to begin the scanning again. This action will clear all the details of the previous
verification.

Any linear barcode will be verified using ten different scan lines, as specified by
ISO/IEC 15416, and the verification grade will be based on the average of these ten
readings.
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Operating the verifier

The bottom right hand section of the window, with the ISO and Details tabs, will
provide you with more information, especially about linear symbols.

If the ISO tab is selected, and you click on the names for each parameter in turn,
you will see the scan lines across the barcode shown in the verifier window. These
will change colour according to whether that parameter has a pass (in green) or a
fail (in red) for that particular scan line. To get a scan reflectance profile of your
linear barcode you can click on the Details tab and select individual scans, and then
a particular scan info (1 to 10). The scan reflectance profile (SRP) will now show at
the bottom of the scan info results. Click on the reflectance profile to enlarge it.

v Scan Reflectance Profile

If you select an area of the SRP using your mouse it will be enlarged. Click away
from the enlargement to return to the complete SRP. With a 2D symbol only the
ISO tab will appear. When there are several === = - -

symbols, click on each in turn to see its
results. The now solid border will change to
different status colours to indicate whether
the symbol has passed or failed. Now click

on the selected symbol to enlarge it. To see
how each module has been assessed, click on
the name of one of the parameters. The size
of the circle shows the aperture size, and a
change in colour will highlight any relevant
modules for that particular parameter. Blue is
the neutral colour for all these displays.
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Cropping

If the verifier has to look at a complicated image, with a number of barcodes,

and other images with rectangular edges, the software will take some time to
make sure that any rectangular edges are not plausible 2D barcode images before
decoding all the barcodes correctly. Cropping the image so that it only contains
the barcode you are interested in will speed up this process. This cropping will also
reduce the size of the scan file.

@8 Axicon Camera Verifier - [m] >
File View Reader Help

SON

e | Settings.. Calibrate... | UserData

Reposition the verifier during the scanning process so that the barcode is
approximately in the centre of the field of view. Then left click outside and above
the barcode, and a rectangular crop box will be drawn in the centre. You may need
to click again to make sure the box is large enough, and you may need to re-centre
the barcode. Now click on the ‘Search for barcodes’ icon or press one of the verifier
buttons. The crop box will become the whole image, the image in the box will be
decoded, and the verification results will appear on the right. The rest of the field
of view will have been ignored.
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Cropping

Click on the selected image to 8 txcon Cames Vi
enlarge it, and click again to take |—.|.

0
it back to its original size. 19 H =

Quit can... Print Report: "Standard PDF"

1

g Decode

Stop scannin

Clicking on the orange arrow icon
to restart the scanning process
(for another barcode) will reveal
that the cropping box is still
present inside the original field
of view. Right clicking within the
image panel will remove the box,
and left clicking will create a
new crop box.

Gen

@ Axicon Camers Verifier - o x

> RDOM

Start Scanning  Decode | Seffings.. Calibrate., | User Dota.

File View Reader Help

H =

Load scan... Save scan... Print Report: "Standard PDF"

P

Quit

Application Validation: N/A

General Reader Scan

6680333

Code 128
Pass grade 15
X Dimension 2522 um
P Gin Cmemimemon
Height 7.3mm
‘Width 27.9mm
Aperture 125 um
Left Quiet Zone 10 items: 10 Pass.
Right Quiet Zone 10 items: 10 Fail

1s0 Details

overa
Maximum Reflectance 88.9%*
Threshold 445%*
Reflectance Margin TO0%*
Defects 02 41.2%*
Decodaity wmo
Decoce
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Saving and using scan files

The image, and verification and plugin results of any codes that have been verified
can be saved in a scan file. This is done by choosing ‘Save scan...’” from the File
menu.

The scan file is the basis for the verification reports that are created from it. For
example, one scan file may include four barcodes if each one has been decoded and
each barcode will have its own verification results.

To open a saved scan, select Load Scan from the File menu.

When a saved scan file is opened by the application, the original data is available
and displayed. In addition, the original image can also be re-verified using the
‘search for barcodes and decode them’ icon - this will then automatically use any
plugins that are activated regardless of whether the plugins were used at the time
of original verification. The plugin details will be included in each verification
report.

The full verification results are then shown and reports can be viewed (and printed)
as required.
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Saving and printing reports

@ Axicon Camera Verifier

Eile View Reader Help

H Ssevescan Ctrl+S
Load scan. Cti-0 q ”
Save Report: “Standard PDF" CtrlsR b W
T S e NaBEaE R | Settngs. Ceibrets. | UserDsts..
Append Report > Data Matrix CSV .

+| OpenReport Detailed plugins HTML

Standard CSV.

Application Validation: N/A

o
Detailed plugins (PDF) L 2017-01 51 DataMatrix

Standard PDF
QR Code CSV

Pass grade
Minimum Reflectance
Maximum Reflectance

12051234

GTIN 7332561925352 GTIN 7332551925352 S o
' X Print Gain
B "1 REF 80000527 i
[LoT] 12051234
. - (d 2017-01
| 77332551"925352 . i

Overall

Decode

Symbol Contrast
Axial Non-Unifarmity
Grid Non-Uniformity
Modulation
Reflectance Margin

TN REF 80000527 .
[oT] 12051234 |
4@ 201701 EEES

71332551"925352

Unused Error Correction
Contrast Uniformity
Fixed Pattern Damage

Print Report: "Stendard PDF* CirleP - |
Print Report > SRR | General Reader Scan

Standard plain text 3| REF 80000527
Quit Curl-Q Linear CSV G 0107332551925352171701001012051234

15

4%

u%

492um

493 um

-2 um, 5%
62 um, -12%
400 pm

&
=

Found codes: 4

A verification report may be saved in .csv, .pdf, .html or .txt formats. Additionally
reports can be manually saved for subsequent printing or printed without saving.

Select ‘Save Report’ from the File menu and select the required format from the
list. This selection will be remembered and can be repeated with the shortcut

Ctrl + R.

If you want the report to be automatically opened on creation (for example, if
there is a need to print the report) then tick the ‘Open Report’ box.

You can append verification reports if you are using a CSV format, and you have
ticked the ‘Append Report’ box. If this box is left unticked and the file name is not

changed, the data will be overwritten.

Axicon Auto ID Limited | 15000 series verifier user guide | June 2021

Page 16 of 32



www.axicon.com

Settings

The verifier has a range of configuration settings. These can be set by clicking on
View and then selecting Settings.

Appearance: The Appearance tab allows you to set the appropriate colours for
“Fail”, “Warning” and “Pass”, choose the language, set the units of measurement
to metric or imperial units and set the pass grade. Plugins (chosen on the next
tab) will often have pass grades, but if you want to set a higher value for the pass
grade, make the change here. Hover text will appear to help you understand these
settings. The appearance tab also offers the option to resize the appearance of the
toolbar and to show text.

Plugins:
i Settings — m} X
Appearance  Plugins Reports Saving UserData Calibration Advanced
Available Plugins: Plugin Description:
~ | This plugin will recommend that an aperture of 80% of the module size of a two
Brazil Healthcare of dimensional code should be used for verification.
Clp Default (Off)
Code 39 Check Character Default (On)
DAVA Heslthcare Default (Off)
G51 Data Content On
G51 Distribution Default (On)
G51 Documents, Aszets & Locations Default (On)
(51 Global Service Relation Numbers Off
G351 Healthcare (bedside) Off
G571 Healthcare Retail Off
G51 Pharmacy & Distribution Default (On)
G51 Retail (point-of-sale) Default (On)
G51 Retail (point-of-sale) & Distribution Default (Off)
HIBC Default (On) Default aperture (2D)
ITF Check Digit Default (On) @ IS0/IEC 15415
Luhn Check Digit (ITF) Defauilt (Off) () Percentage of module size: : %
Perfermance Qualification Off O Fixed value: 200 : um
Pharma Pack Default (Off) hd
‘Ask User' plugins ‘When no plugins recommend an aperture (20)
[ Allow multiple 'Ask User' plugins for each scan 8:{1’;;:‘1“':::3;““
[J &llow to not apply any ‘Ask User' plugin () Show prompt
v o
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Settings

Plugins: The Plugins tab is used to select how the symbols will be checked for
their data content, their dimensions, and any other aspects defined by a particular
application. These include GS1 Data Content, which will check for correct
combinations of application identifiers, GS1 Retail (point-of-sale) which will check
the type and size of the barcode, and many more. By default, many plugins are
switched off. To change this, select the plugin you require, and choose from the
drop-down list: On will check relevant codes, Always Show will check every code,
and Off will deactivate the plugin.

The plugins tab also offers the choice to change the default aperture for 2D
barcodes and to prompt when no plugins recommend an aperture.

Reports

#5 Settings - O X

Appearance Plugins Reports Saving User Data Calibration Advanced

Data Matrix CSV Standard PDF
Detailed plugins (PDF) .
Detailed plugins HTML [save [print
Linear CSV File Name
QR Code CSV
Standard CSV Use Decode
Standard HTML Use Date & Time
Standard PDF .
Standard plain text Directory:
Template: available-tags.txt ‘ “:
[ save As
[ Allow Cancel
Show In Menu
Report Source: C:\Program Files\Axicon\Camera Verifier\scripts\reports\pdf.lua
« OK X Cancel
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Reports: In this window you can enable automatic saving and/or printing of reports.
Select the type of report file and choose an output file where the data will be kept.
There is an option to add the records to an existing file rather than replacing the
file, which is of benefit with text files, including CSV files. Choose Append and then
where you want these reports kept.

If Use Decode box is ticked, the report name will automatically be created using
the first digits of the decoded number.

If Use Date and Time box is ticked, the report name will automatically be created
using the date followed by the time as a file name.

If Use Decode and Use Date and Time boxes are both ticked, the file name will
automatically be created using the decoded number followed by the date and time.

Saving: The Saving tab can be used to enable automatic saving of all of the scan
files for audit purposes. The enable box must be ticked for the software to save the
scan files. Browse to your chosen location in the directory.

If Use Decode or Use Date & Time (or both) are ticked, then the dialogue box
will appear with the pre-selected data and allow the operator to override this if
required.
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Settings

User Data: User Data allows you to program the Axicon 15000 series software to
ask questions when a verification is being made, to collect the answers and to store
these with the verification report. This supplementary user data will then always be

displayed with the verification report.

Such data may typically be a job reference
number or batch number, but equally it could
be information about the barcode such as the
substrate or print process or details about the
operator, the department or the site. Multiple
questions can be entered if desired.

To set up the User Data:

From the View menu select Settings. Click on the
User Data tab of the Settings window. To add a User
Data item press the + symbol at the bottom left of
the window. The Create User Datum window will be
shown. This can now be completed as required.

An example of a Job Reference entry is shown here.
The title is entered and the Allow Blank is un-ticked
to force you to enter data into this field.

This sample shows how you can be offered a pull-
down menu of options but with a default option
given. The default can be left blank. When the list
of selected questions has been completed press the
OK button.

Now when you verify a barcode and select ‘save’
scan the User Data dialogue window will appear and
allow you to enter the required information. If you
now save the scan file the User Data information is
automatically saved with it.

#8 Create User Datum — O X

Item Title:

Allow Blank Content
Allow Edit
Default:

‘ v

[ Reset to default value each scan

Pass Value:

[ Check value
Preset Values:
v ox

#% Create User Datum — O X

Item Title:

‘Test

Allow Blank Content

Allow Edit

Default:

‘ Finished products ~

[JReset to default value each scan

Pass Value:

[ Check value

Preset Values:
Artwork

Proof

Label

Finished producd

X Cancel
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When loading a pre-saved scan file for which User Data has been attached you
simply need to load the scan file, and re-verify the code using the Search for all
barcodes icon and then select View/User- Data from the pull-down menu.

The Axicon software also includes a facility for transferring the User data settings
from an existing scan file (whether made from this computer or not). Simply load an
existing scan file, go to the View/settings/User Data screen and then press the ‘Add
the user data fields’ icon.

There are also facilities to edit an existing User Data entry (ideal for adding items
to a pull-down menu). You can also clear any existing User Data requirements and
prompt the user data to always show.
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Settings

Calibration

@ Settings — O =
Appearance Plugins Reports Saving UserData Calibration  Advanced

Calibration card reflectance
RMin: : RMax: :

Expiry

Y

Days until calibration reminder:

-

7] Allow scanning when calibration expired

« OK ¥ Cancel

This windows allows users to enter the minimum (RMin) and maximum (RMax)
reflectance values for calibration (see page 7).

This windows also allows the option to change days until calibration reminder and
to allow or not scanning when calibration has expired.
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Advanced: This window allows you to lock all the settings for the verifier so that
other users cannot change them, and to require individual users to login before
using the software. A supervisor, who will take control of making any configuration
changes for all of the users, needs to follow the instructions below to ensure that
users have the same settings and are not able to make changes to those settings.

By default the settings for the Axicon Camera Verifier software are independently
configurable by each user of the software. This means that if several people use the
same PC and verifier, and login in with their own user names and passwords, they
can each change the settings to suit their use of the verifier.

The process of calibrating the verifier results in the

storage of data that is used by all users, so that a k] users Properties x
change of user will not require the verifier to be Genera | Seculy  Detals | Frevious Versions
re-calibrated. By default all users are allowed to LT e

calibrate the verifier.

Type of file:  Configuration settings {ini)
Opens with: 7| Notepad Change...

To use this window you will need to change the
read-only attribute for the ‘users.ini’ file, which

Location: C:\Program Data‘\Axicon\Camera Verfier

Size: 126 bytes (126 bytes)

is in the common configuration directory. This file Soeandsk Dbstes
normally has a read-only attribute which disables _ _
. A . . Created: 30 January 2018, 16:00:04
the common configuration and user login settings. Vodfed 30 May 2015, 145454
This is done to prevent changing the settings by hocessed 01 dune 2013, 05,3935
accident because it will affect all users on the pies sty Clideen | Advarcad.
computer.

Go to the hidden folder “C:\ProgramData\Axicon\

Camera Verifier”, right-click on ‘users.ini’, select N
‘Properties’ and untick the ‘Read-only’ tick box and
click on ‘OK’.

Restart the camera verifier software and the common configuration and user login
options will now be enabled in the Advanced window of the Settings dialog.
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Settings

@ Settings When a supervisor ticks the ‘Use
common configuration’ box, all
the settings that the supervisor
has made will be applied to
everyone that uses the computer.
The settings are now locked by
the supervisor that enabled the
option and only this user can
disable it.

Appearance Plugins Reports Saving UserData Calibration Advanced
Configuration Files
Use commaon configuration
Requires a software restart to take effect,
Ul settings: Ch\Users\x¥\AppDatat\Local\Axicon\ Camera Verifier\acvgui.ini
Decode settings:  Ch\Users'\xx\AppData'\Local\Axicon' Camera Verifier\decode.ini

Reader settings:  C:\ProgramData\Axicon\Camera Verifier\reader.ini

Reader log: C\ProgramData\Axicon\Camera Verifier\reader.log

User Login
Require user login

Requires a software
restart to take effect,

5 Settings

Appearance Plugins Reports Saving UserData Calibration Advanced

Configuration Files

Use common configuration

Requires a software restart to take effect.

Ul settings: CA\ProgramData’ Axicon\ Camera Verifier\acvgui.ini
Decode settings:  C\ProgramData'Axicon\Camera Verifier\decode.ini
Reader settings:  C:\ProgramData\Axicon\Camera Verifier\reader.ini

Reader log: C\ProgramData’Axicon\Camera Verifier\reader.log

User Login
] Require user login

Requires a software restart to take effect.

Optionally the ‘Require user
login’ box can be ticked, then
every time a person opens

the software, the computer’s
Windows operating system login
screen will appear.

You must restart the software
now so that these changes take
effect. If you return to this
window, you will see that it now
looks like the image on the left.

After restarting the software, the
Advanced tab of the configuration
window shows the location of

the configuration files for the
software which apply to all users.
Decode settings will normally be

blank and are mainly for testing purposes. User Interface (Ul) settings (the ‘acvgui.
ini’ file) are for the configuration options that are available through the settings
dialogue and after enabling the ‘use common configuration’ option these settings
will be assigned read-only permission for all users except for the supervisor who will
have full control.
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If an organisation wants to grant X o Popti x
permission for an additional by | Erbii e rp—
supervisor to be able to modify the
software configuration settings, T 2 S TOPRSFN )
then the Windows security settings
for that additional supervisor needs Tochrmeemssons, ik i e To g s, i e
to be set to allow write and modify e o o e
permissions for the acvgui.ini file on o o A R
the Security tab of the properties o v - v
dialogue which is accessed through e ] | [
Windows File Explorer. e e

Cancel hosly o e
Reader settings (the ‘reader.ini’ file)
stores the calibration data for each 7T N )
verifier that has been connected B Tt Ry | |l e s Vst
to the computer and calibrated. R i
By default, all users will be able to | T TR

calibrate the attached verifier as

all users will have write permissions m"“Ed o= =L =
for this file. If an organisation wants e : y : ”W B
to limit which users can perform ez v — v
calibration, then the permission to - v ¥

write to the reader.ini file should be st | g P e peons o aarcod i1, | Ans
denied for individual users or groups

of users, as shown in this properties C=m) ] I
dialogue for ‘User1’. Any users (or groups of users) that are not denied permission
to write to this file will continue to be able to calibrate verifiers on the computer.

In the Advanced tab of the settings menu there is also an Audit Log option. This will
create a log of all settings changes, saving, printing and calibration operations. It
is recommended that either autosaving of scans or reports (or both) are enabled so
that every verification scan is recorded in the audit log. All entries in the log will
include the time and date as well a record of the user that is running the software.

A copy of the audit log can be exported (as a .csv file) by clicking on the ‘Export to
CSV’ button.
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Warranty

Axicon 15000 series verifier is sold with a two year parts and labour warranty
against manufacturing defects. This is a return to bench warranty with shipping
costs in one direction being borne by the customer/distributor.

Should you need to return the unit to Axicon the original case (plus appropriate
packaging) must be used. If the equipment is returned without the original case, we
will automatically charge an additional sum for its replacement.

Axicon’s standard repair turnaround time is 7-10 working days. This standard
warranty does not include the provision of a loan unit. Loan units can be supplied
on request.

Axicon reserves the right to charge an inspection fee for any equipment returned
under warranty for which no fault is found. Please contact us to obtain an RMA
number before returning any equipment. This number must be quoted on all
documentation. We cannot accept responsibility for equipment returned without an
RMA number.
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Maintenance agreement

A service contract may be purchased within 30 days from the date of despatch.
This allows you to return your verifier back to us at no extra cost for its annual
VCAS (verifier conformance and alignment service) so that you can be sure it still
measures barcode quality in accordance with the requirements of ISO/IEC 15426-1
and ISO/IEC 15426-2.

The service contract will also extend the warranty beyond two years, so that if it
breaks down, all parts and labour will be provided free of any extra charges. The
only exception is when the verifier has been misused, in which case labour costs
will be covered, but not those of the parts.
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Software licence agreement

This software is Copyright © Axicon Auto ID Limited

Use of the software is subject to the Axicon software licence terms set out below.
Using the software indicates your acceptance of these licence terms. If you do not
accept these within 14 days, you may return the entire unused product for a full
refund.

Axicon grants you a licence to use any number of copies of the software, but only
for use with an Axicon verifier. “Use” means storing, loading, installing, executing
or displaying the software. You may not modify the software or disable any of its
licensing or control features.

Ownership

The software is owned and copyrighted by Axicon Auto ID Limited. Your licence
confers no title or ownership in the software and is not a sale of rights in the
software.

Copies

You may only make copies of the software for archival purposes or when copying is
an essential step in its use. You must reproduce all copyright notices in the original
software on all copies. You may not copy the software onto a bulletin board or
similar publicly accessible system.

No disassembly or decryption
You may not disassemble or decompile the software without prior written consent
from Axicon.
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Transfer

Your licence will automatically terminate upon any transfer of the software.

Upon transfer, you must deliver the software, including any copies and related
documentation, to the transferee. The transferee must accept these licence terms
as a condition of the transfer.

Termination

Axicon may terminate your licence upon notice of failure to comply with any
of these terms. Upon termination, you must immediately destroy the software,
together with all copies, adaptations and merged portions in any form.

Export requirements
You may not export or re-export the software in contravention of any applicable
laws or regulations.

This agreement should be construed in accordance with the laws of England.
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Disclaimer

In the following the expression Verifier means the verifier hardware and the
associated software.

We have taken care to ensure that this Verifier is free from defects. However since
we have no control over the circumstances in which you might use the Verifier,

you must satisfy yourself that the performance of the Verifier is suitable for your
needs. Neither Axicon Auto ID Limited nor the vendor of this Verifier can accept any
liability for any loss or damage (consequential or otherwise) which may be caused
by use of this Verifier.

If the Verifier or any part of it is defective in any way, or in some other way does
not meet your expectations, the liability of Axicon Auto ID Limited is limited to the
cost of the product. You should bear this limitation in mind if you use this Verifier
in any situations where the acceptance or rejection of shipments of goods or your
reputation may depend upon the quality of a barcode.
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Annual service

All verifiers need servicing every year to ensure that they measure barcode quality
in accordance with the relevant ISO/IEC standards. This verifier conformance and
alignment service (VCAS) ensures that the verifier is internally dust-free, checks
that it is focused correctly, and adjust the hardware to account for any change in
the brightness of the LEDs used to illuminate the barcodes.

This annual service is not the same as user calibration, as it looks at the output of
the LEDs and corrects for any variance in their evenness of illumination across the
whole field of view. Over time the LEDs will fade but they will not fade uniformly.
User calibration ensures that the verifier is measuring the darkest and brightest
reflectance’s correctly but it cannot correct for any variance in the illumination.

After your verifier has been serviced, we will return it you with the latest version
of the software on CD together with a new calibration sheet, and a new user guide
that will include the new certificate of ISO/IEC conformance. You will then need
to calibrate the verifier before you use it again. The latest software can always be
downloaded free of charge from our website, www.axicon.com.
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Contact us

Axicon Auto ID Ltd
Church Road

Weston on the Green
Oxfordshire

0OX25 3QP

UK

Tel: +44 (0) 1869 351 155
Fax: +44 (0) 1869 351 205
Email: info@axicon.com
Website: www.axicon.com

As Axicon continually improves its products, their specifications and features are
subject to change without notice. All trademarks are acknowledged as belonging to
their respective companies.

EU authorised representative:
Axicon BV, Spoorstraat 55M, 5831CJ Boxmeer, The Netherlands

Your Axicon distributor




